Experiment 6: Chemical Kinetics

Purpose: Determine the rate law for the reaction of the dye crystal violet with hydroxide.

Reading: Olmstead and Williams, Chemistry, sections 13.3 and 13.4.

Introduction

The reaction of crystal violet with hydroxide is:

\[
\text{CV}^+ + \text{OH}^- \rightarrow \text{CVOH}
\]

This reaction can be represented as:

\[
\text{CV}^+ + \text{OH}^- \rightarrow \text{CVOH}
\]

purple colorless

The kinetics of this reaction can be monitored with a spectrophotometer by observing the decrease in absorbance of crystal violet with time. The rate law in general form is:

\[
\text{rate of disappearance of CV} = \text{rate of appearance of CVOH} = k \text{[CV]}^x \text{[OH}^-]^y
\]

Your task is to determine the form of the rate law, including x and y, and the rate constant for the decolorization of crystal violet.

Chemical Kinetics

Consider the hypothetical reaction:

\[
\text{A + B} \rightarrow \text{C + D}
\]

The rate of reaction is measured by observing the rate of disappearance of the reactants A or B, or the rate of appearance of the products C or D. The species observed is a matter of convenience. For example if A, B, and C are colorless and D is colored, the rate of appearance of D can be measured by observing an increase in the absorbance of the solution as a function of time. The rate of reaction is:

\[
\text{Rate of disappearance of A} = \frac{-\text{Change in the concentration of A}}{\text{Change in time}} = \frac{-\Delta[A]}{\Delta t}
\]

\[
\text{Rate of appearance of D} = \frac{\text{Change in the concentration of D}}{\text{Change in time}} = \frac{\Delta[D]}{\Delta t}
\]

---

In general, the rate of the reaction depends upon the concentration of one or more of the reactants. Thus, the rate of the reaction above is expressed as:

\[
\text{Rate} = k[A]^x[B]^y
\]

where \([A]\) and \([B]\) are the molar concentrations of A and B, \(x\) and \(y\) are the powers to which the respective concentrations must be raised, and \(k\) is the rate constant. The values of \(x\) and \(y\) must be determined experimentally. For example, if \(x = 2\) and \(y = 1\), then the rate law is:

\[
\text{Rate} = k[A]^2[B]
\]

This reaction is first order in B, meaning that doubling the concentration of B while keeping A constant causes the reaction rate to double. Simultaneously, this reaction is second order in A, meaning that doubling the concentration of A while keeping B constant causes the rate to increase by a factor of four, since the rate of the reaction is proportional to the square of the concentration of A. The overall order of the reaction is the sum of the exponents: or third order in this case. The orders are determined experimentally by noting the effects of changing reagent concentrations on the rate of the reaction. The rate constant, \(k\), is independent of the concentration. The rate constant is characteristic for a given reaction and varies only with temperature. Once the rate is known for a given set of concentrations, the value of \(k\) can be calculated.

For our reaction of interest, the rate law will be determined by spectrophotometrically measuring the amount of reactant disappearing as a function of time. The values of \(x\) and \(y\) as well as the rate constant \(k\) will be determined for the rate law: \(\text{rate} = k[A]^x[B]^y\). A cartoon of the instrument is provided below.

![Diagram of spectrophotometer](image)

White light illuminates the sample and can be absorbed. The remaining transmitted light enters the spectrophotometer and the absorbance as a function of wavelength is determined and transferred to a computer. The amount of light absorbed by the sample can be determined by measuring the light with the sample in the optical path relative to a reference, or blank. Beer’s Law relates the measured absorbance, \(A\), to concentration, \(C\), of the chromophore as follows:

\[
A = \varepsilon l c
\]

where \(l\) is the path length, which is 1.00 cm in our case, and \(\varepsilon\) is the molar absorption coefficient. Determination of the absorbance allows calculation of the concentration if the molar absorption coefficient \(\varepsilon\) is known for the chromophore at the chosen wavelength. Determination of
absorbance, and thus concentration, over time allows an experimental determination of the rate of the reaction.

**Crystal Violet Decolorization**

The most convenient means of monitoring the rate of crystal violet decolorization is to monitor the loss of purple color over time. Equation (2) shows that the rate of the reaction is equal to the negative of the change in concentration of crystal violet over time, where the change in CV concentration ($\Delta[\text{CV}]$) is measured by the change in absorbance of the solution and the change in time ($\Delta\text{time}$) is the time between measurements. Using finite differences is an approximation because the rate changes over the time interval. However, since we are studying the initial rate of the reaction, a linear relationship between concentration and time may be assumed. Initial rate experiments are performed so that the concentration of reactants remains within 1% of their starting values:

\[
\text{rate} = \frac{-\Delta[\text{CV}]}{\Delta\text{time}} = k[\text{CV}]^x[\text{OH}^-]^y
\]  

Equation (2)

Beer’s Law allows calculation of the concentration of crystal violet using the experimentally determined value of $\varepsilon$:

\[
[\text{CV}] = \frac{A}{(1 \text{ cm})\varepsilon}
\]  

Equation (3)

The first step in this analysis will be to determine the wavelength of maximum absorbance for crystal violet and the corresponding molar absorption coefficient at that wavelength. This wavelength will be used to monitor the disappearance of crystal violet throughout the course of the experiment. The value of $\varepsilon$ is used to convert each absorbance value to its corresponding concentration of crystal violet.

In an initial rate study, the concentration of one reactant is varied while leaving the concentration of the other reactant constant. First, you will vary the concentration of hydroxide, $[\text{OH}^-]$, allowing determination of $y$ in equation (2). As a second step, you will determine $x$ in equation 2.

Because this reaction has two reactants and is likely to follow a complicated mechanism, the reaction orders may not be simple whole numbers. Initial rate studies work well with non-integer order. Taking the logarithm of both sides of the equation 2 gives:

\[
\log (\text{rate}) = \log (k) + x \log [\text{CV}] + y \log [\text{OH}^-]
\]  

Equation (4)

The term $x \log [\text{CV}]$ is constant because $[\text{CV}]$ is constant. The term $\log (k)$ is also constant since the rate constant, $k$, is characteristic of each reaction. Therefore, a plot of $\log (\text{rate})$ vs. $\log [\text{OH}^-]$ gives a straight line with a slope of $y$, which is the order with respect to OH\(^-\). Alternatively natural logarithms, $\ln x$, can be used.

**Example Analysis**

Use the kinetic data provided below for the reaction, $A + B \rightarrow C + D$, determine the order of the reaction with respect to $A$, determine the order of the reaction with respect to $B$, write the rate expression for the reaction, and calculate the rate constant.
<table>
<thead>
<tr>
<th>Experiment</th>
<th>[A] (M)</th>
<th>[B] (M)</th>
<th>Rate (M/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.100</td>
<td>0.100</td>
<td>0.0101</td>
</tr>
<tr>
<td>2</td>
<td>0.100</td>
<td>0.200</td>
<td>0.0206</td>
</tr>
<tr>
<td>3</td>
<td>0.100</td>
<td>0.400</td>
<td>0.0403</td>
</tr>
<tr>
<td>4</td>
<td>0.200</td>
<td>0.500</td>
<td>0.203</td>
</tr>
<tr>
<td>5</td>
<td>0.300</td>
<td>0.500</td>
<td>0.452</td>
</tr>
<tr>
<td>6</td>
<td>0.400</td>
<td>0.500</td>
<td>0.841</td>
</tr>
</tbody>
</table>

Answer: 1. With \( \text{Rate} = k \ [A]^x \ [B]^y \), to determine “x”, the data from experiments 4-6 are used, because \([A]\) varies while \([B]\) remains constant in these experiments. A plot of \(\log(\text{rate})\) vs. \(\log \ [A]\) for experiments 4-6 gives a slope of about 2, Figure 1. The uncertainties in the concentrations and rates are around 2%. Therefore \(x = 2\), within experimental uncertainty.

![Figure 1: \(\log(\text{rate})\) vs. \(\log \ [A]\) novel.png](attachment:Figure_1.png)

2. The value of “y” can be determined by plotting \(\log(\text{rate})\) vs. \(\log \ [B]\) for experiments 1-3. This yields a slope of about 1, Figure 2. Therefore \(y = 1\), within experimental uncertainty.

![Figure 2: \(\log(\text{rate})\) vs. \(\log \ [B]\) novel.png](attachment:Figure_2.png)

3. Rate = \(k \ [A]^2 \ [B]\).

4. The rate constant can be determined from any single experiment. For example, using the data in experiment 3: \(0.0403 \text{ M/sec} = k \ (0.100 \text{ M})^2 \ (0.400 \text{ M})\), or \(k = 10.1 \text{ M}^{-2} \text{ s}^{-1}\).
Comparing the Time Course to the Integrated Rate Laws

An initial rate study is an excellent method for determining the order with respect to hydroxide, since hydroxide is not a colored species. However, since crystal violet is the colored reactant, a time course study is a better method for determining the reaction order with respect to crystal violet. In a time-course study, the concentration of a reactant or product is followed as a function of time and compared to the integrated rate laws for different order reactions.

First-Order Rate Expression

The rate law for a reaction that is first-order in the reactant is:

\[
\text{rate} = -\frac{d[A]}{dt} = k[A] \tag{6}
\]

This rate law applies to the type of reaction with one reactant, for example \( A \rightarrow \text{Products} \). How can we apply this rate law for our reaction, which is in the form of \( A + B \rightarrow \text{products} \)? In comparison with equation 2, the first order rate law in equation 6 would result \( x = 1 \) and \( y = 0 \) or if \([\text{OH}^-]^y\) is kept constant and included in \( k \).

\[
\text{rate} = (k[\text{OH}^-]^y) [CV]^x = k_{\text{eff}} [CV] \tag{7}
\]

The effective rate constant is \( k_{\text{eff}} = (k[\text{OH}^-]^y) \). In other words, the first order rate law works fine, but we get an effective first order rate constant, \( k_{\text{eff}} \), that includes the effect of the concentration of hydroxide. Keeping \([\text{OH}^-]^y\) constant can be done experimentally by having hydroxide in great excess, in which case, the overall concentration change of hydroxide during the course of the reaction is negligible. The process is then said to be pseudo-first order in CV. The integrated rate expression is,

\[
\ln \left[ \frac{[CV]}{[CV]_o} \right] = -k_{\text{eff}} t \tag{8}
\]

or

\[
\ln [CV] = -k_{\text{eff}} t + \ln [CV]_o \tag{9}
\]

where \([CV]_o\) is the initial concentration of CV at time zero and \([CV]\) is the concentration at any time, \( t \).

Second-Order Rate Expression

If \( x = 2 \) and \( y = 0 \) or \([\text{OH}^-]^y\) is held constant in equation 2:

\[
\text{rate} = -\frac{d[CV]}{dt} = k_{\text{eff}} [CV]^2 \tag{10}
\]

the reaction is pseudo-second-order in CV and integration of equation 10 gives:

\[
\frac{1}{[CV]} - \frac{1}{[CV]_o} = k_{\text{eff}} t \tag{11}
\]

Determining the Reaction Order

Since absorbance is directly proportional to concentration, according to Beer’s Law \( A = \varepsilon c \), the absorbance can be used for the curve fitting in place of the concentrations. For a first order reaction, the absorption coefficient cancels in the numerator and denominator of the \( \ln \) term in Eq. 8, so either concentration or absorbance may be used to directly determine the rate constant. For a second order reaction, since \([CV] = A/\varepsilon l\),
\[
\frac{1}{A} - \frac{1}{A_o} = \frac{k_{\text{eff}}}{\varepsilon f} t
\]

(12)

where \( A_o \) is the initial absorbance. To determine the order of a reaction, absorbance versus time measurements are collected and the data are plotted. For a zero order reaction, the concentration or absorbance versus time plot is a straight line. According to equation 9, for a first-order reaction a plot of \( \ln [\text{CV}] \) or \( \ln A \) versus \( t \) should yield a straight line with a slope of \( k_{\text{eff}} \). According to equation 11 and 12, for a second-order reaction a plot of \( 1/[\text{CV}] \) or \( 1/A \) versus \( t \) is a straight line.

**Procedure**

You will use automatic micropipettors for precise and accurate delivery of small volumes. There are three sizes of Finnpipettes® in the lab: 5.0-40 \( \mu \)L (orange), 40-200 \( \mu \)L (yellow), and 200-1000 \( \mu \)L (blue). These numbers refer to the maximum volume in microliters (\( \mu \)L) that can be delivered; e.g., the yellow ones can dispense a maximum of 200 microliters. Never dial a pipettor past the maximum volume. The 200-1000 \( \mu \)L pipettors take blue tips; the 5.0-40 \( \mu \)L and 40-200 \( \mu \)L both take yellow tips. To draw the sample into the pipette tip, push the button down to the first notch, immerse the tip in the sample, and slowly release the button. Check the tip to make sure you didn’t capture any air bubbles. To dispense the sample, push the button all the way down. **If you have any questions about the micropipettors, please ask your instructor or TA before use.** Micropipettors can be severely damaged if they are incorrectly dialed.

The first step in your analysis is to determine the wavelength of maximum absorbance of the chromophore (crystal violet in this case). You will use the absorbance of a solution of known concentration of crystal violet to calculate the value of the absorption coefficient at this wavelength. Please consult the “SpectroVis Plus Spectrophotometers with Vernier Data Acquisition Software Instructions” Sections I-IV (found on the lab webpage as SpectroVisInstructionsKinetics.pdf) for detailed instructions on the use of the instrument. **Note** that your reference cuvette should contain water for all calibration procedures below.

**A. Preliminary Experiment to Determine \( \lambda_{\text{max}} \) and \( \varepsilon \)**

1. Keeping your total solution volume 3.00 mL in all cases, take the absorbance of a solution of crystal violet in water. A stock solution of \( 1.00 \times 10^{-4} \) M crystal violet will be available for you to use, and you should keep the maximum absorbance value below 1.5. It may take a few dilutions to obtain a good spectrum that is on-scale, but you can collaborate with another student to determine an appropriate concentration. Be as accurate as possible when making up your solution as you will use this concentration to calculate the absorption coefficient.

2. Once you find an appropriate dilution, make sure that you record both the \( \lambda_{\text{max}} \) and the absorbance at that wavelength on your own spectrophotometer. Wavelengths may differ from spectrophotometer to spectrophotometer.

3. Use Beer’s Law to calculate the value of \( \varepsilon \) for crystal violet based on your measured absorbance value and your concentration (the path length is 1 cm).

**B. Kinetics Experiments with Crystal Violet Constant, Variable Hydroxide**

In this set of experiments you vary the volume of sodium hydroxide, \( \text{NaOH} \), added while keeping the volume of crystal violet constant.
1. Set up an absorbance vs. time run on the SpectroVis Plus spectrophotometer at the experimentally-determined $\lambda_{\text{max}}$, and collect data every 4 seconds for 90 seconds. Again, the total volume of each trial should be 3.00 mL. Your first kinetics trial should contain a volume of crystal violet that will give an absorbance of about 1.2-1.5 (based on your findings from Part A). Plan to add the same volume of 0.100 M NaOH as you have of crystal violet, but don’t add it yet! Add the crystal violet to your cuvette, then the appropriate volume of water that will make your final volume 3.00 mL (be sure to account for the NaOH that you’re about to add). Finally, add the NaOH, mix with the pipette tip, and immediately start collecting kinetic data with the spectrophotometer. You should see the absorbance drop as the crystal violet decolorizes in the presence of base. When data collection is complete, save the data using Save As… from the File menu as described in the SpectroVis Plus Instructions. Determine the initial rate as described in Part C. Data Analysis, below.

2. Set up another 3.00 mL reaction, this time with less hydroxide than in the first trial (but make sure that you know this amount exactly). Again, add the same volume of crystal violet as last time (this amount will remain constant in this whole series of trials), water (make sure that you increase the volume of water to make up for the decrease in the amount of hydroxide). Add the 0.100 NaOH, and collect kinetics data again and save this data to disk. Don’t overlay the data; in other words, pull down the Data menu and choose Clear All Data before each run.

3. Repeat until you have five kinetics trials, each with a total volume of 3.00 mL, a constant volume of crystal violet, and a known, varying amount of hydroxide.

C. Initial Rate Study Data Analysis

1. Observe the data table in the Vernier software. The first column should be time in seconds; the second column, the absorbance.

2. Using the following instructions, insert a new column for crystal violet concentration, using the absorbance data and your absorption coefficient calculated in Part A above to determine these values ($c = A/\varepsilon$; path length is 1 cm). Choose New Calculated Column from the Data menu. Enter “[CV]” as the Name, “[CV]” as the Short Name, and set the unit to “M.” Enter the correct formula for the column into the Equation edit box: to do this, select “Absorbance” from the Variables list. Then type in “/” and your absorption coefficient. In the Equation edit box, you should now see displayed something like: “A”/1.234e4. Click Done. Click on the y-axis label in the plot window. Choose [CV] and uncheck any other boxes. The crystal violet concentration should now be plotted as a function of time.

3. Autoscale the y-axis by clicking on . To do the linear curve fit, click the Linear Fit button, The slope of the best-fit line can be used to determine the initial rate of the reaction for that experiment. We recommend that you use four significant figures in your determination of the slope.

4. Repeat your initial rate determinations for each of the five kinetics trials that you perform in lab today. You now have a set of data that contains a rate for each initial hydroxide concentration.

5. Plot log(rate) vs. log $[\text{OH}^-]_{\text{initial}}$ in Excel. You can also use natural logarithms, ln. The slope of the best-fit line is the reaction order for $\text{OH}^-$ (“y” in the rate law equation (2) above).
D. Time-Course Kinetics Experiments

1. Again, the total volume of each trial should be 3.00 mL. Your first kinetics trial should contain the volume of crystal violet that gives an absorbance of about 1.2-1.5. Choose the amount of sodium hydroxide from last week’s experiment that gives a half-time of about 1.5 mins; the half-time or half-life is the time it takes for the concentration to drop by a factor of two. Add the crystal violet to your cuvette, then the appropriate volume of water that will make your final volume 3.00 mL (be sure to account for the NaOH that you’re about to add). Finally, add the NaOH, mix with the pipette tip, and immediately start collecting kinetic data with the spectrophotometer. Collect data every 4 seconds for about 900 seconds. When the curve starts to look “flat,” stop collecting. Save the data as described in the SpectroVis Plus Instructions.

2. Use the Data Analysis Instructions in the “SpectroVis Plus Spectrophotometers with Vernier Data Acquisition Software Instructions” Data Analysis Section. Determine the reaction order, and rate constant. This rate constant is the effective rate constant, see the Time-Course Data Analysis section below.

3. You only need to complete one run successfully. If your curve fitting didn’t work out well, because the reaction ran either too fast or too slow, repeat the experiment with a different amount of hydroxide.

E. Time-Course Data Analysis

1. The rate constant from Part D is an effective rate constant, \( k_{eff} \), since at the given concentration of the sodium hydroxide: rate = \( (k[OH^-]^y) [CV]^x \) = \( k_{eff} [CV]^x \); see equation 7. Therefore the rate constant that you determined in Part D is \( k_{eff} = (k[OH^-]^y) \). Determine the true rate constant, \( k \), from the effective rate constant.

2. Now that you have determined the values of both “x” and “y”, determine the value of the rate constant, \( k \), for all five of the reactions in your initial rate study from Part B. Show your calculations in your lab notebook. Calculate the mean and the standard deviation of the rate constant values. Compare this average value with the rate constant from Part D. Consider the effect of random and systematic errors on the difference.

LABORATORY REPORT: Use the Report form for this experiment.

Use complete sentences, the proper number of significant figures, and include units. Equations, reactions, tables, and diagrams can be written by hand. The sections of your report are:

**Introduction (2-sentence maximum):** State the scientific purpose of the experiment. Describe the method you will use, in a general sense. Do not discuss the experimental procedure details or data analysis steps. Don’t include pedagogical goals (e.g. teach us how to use…).

**Procedure:** Give one-sentence descriptions of the two methods that you used to determine the order of the reaction with respect to crystal violet and hydroxide. Reference the lab write-up on the CH145 On-line Laboratory Manual and list any changes. Give the cell material and path length and the manufacturer and model of the spectrophotometer.

**Results:** Give the temperature of the kinetics determinations. Give your results in tabular form for the concentrations and initial rates for the determination of the order with respect to hydroxide. Report the slope and intercept of the curve fit for the order determination. Attach the plot used for the initial rate study. Make sure the axes are labeled. Give the concentrations and
rate constant for the time course study that was used to determine the rate constant with respect to crystal violet. Attach the **two** plots used to determine the order with respect to crystal violet. Report the slope and intercept of the curve fit of the order determination with respect to crystal violet. Report the rate constant from the time course study. Report in tabular form the rate constants calculated from the five initial rate studies, along with the average and standard deviation. Make sure to mention any student errors that may have caused problems in the determinations. All tables and plots should have a table or figure number and a caption. Refer to this Table or Figure with an explicit reference (e.g. see Figure 3) in the text of this section.

**Discussion:**

(a). Purpose accomplished: Restate the purpose of the experiment, but as completed goal.
(b). Write the reaction that you are studying.
(c). Give the final results for the order with respect to hydroxide. Discuss if the order is sufficiently close to an integer value or a simple rational fraction (e.g. \( \frac{1}{2}, \frac{3}{4}, \text{etc.} \)).
(d). Give the results for the order of the reaction with respect to crystal violet. Describe how you reached your conclusion.
(e). Give the results for the average rate constant from the five initial rate studies and the rate constant from the time course study.
(f). Consider the effect of random and systematic errors on the difference in Part e.
   (i). Name the predominant random error in the measurements and estimate the effect on the determination of the order with respect to hydroxide and if the result is sufficiently close to an integer. Determine if the difference between the average rate constant from the initial rate studies and the time course measurement are explained by random error.
   (ii). Suggest a source of systematic error. Remember that student mistakes are neither random nor systematic errors; student mistakes are just student mistakes. What effect does the source of systematic error have on the final results? (For example, does the systematic error cause curvature in the plots or increase or decrease the value determined for the reaction orders or the rate constants?)
(g). To summarize the experiment answer the following questions:
   (i). In the kinetics studies, you always brought the total volume in the cuvette to 3.00 mL. Why is constant volume necessary?
   (ii). What advantages or disadvantages do initial rate studies have in comparison to time course studies in determining the order of the reaction with respect to a given reactant?

**Literature Cited:** Give all literature cited, numbered according to the references in the body of your report.

Attach the plot used for the initial rate study. Attach the **two** plots used to determine the order with respect to crystal violet.